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ABSTRAK

RANCANG BANGUN PROTOTIPE MESIN PENGADUK MINUMAN (MIXING DRINK MACHINE). Telah dilakukan
Rancang Bangun prototipe mesin pengaduk minuman (mixing drink machine). Prototipe mixing drink machine adalah salah
satu pemanfaatan dari sistem komputerisasi otomatis sebagai contoh berkembangnya Ilmu Pengetahuan dan Teknologi
(IPTEK) yang semakin meningkat dengan pesat seiring dengan meningkatnya kebutuhan manusia yang semakin besar.
Prototipe mixing drink machine ini merupakan system otomatisasi menggunakan PLC Mitsubishi FX;y untuk mengolah data
yang telah terprogram pada memory PLC menjadi sebuah proses otomatisasi secara menyeluruh. Rancang bangun prototipe
ini bertujuan untuk mengaplikasi sistem otomatisasi menggunakan PLC Mitsubishi Fx1ln dengan push buttom, proximity,
sebagai input dan motor dc, solenoid valve, lampu, sebagai output. Alat ini terdiri dari motor dc yang berputar disekitar
tabung yang berisikan bahan-bahan minuman antara lain kopi, gula, susu dan air. Mixing drink machine di program untuk
pembuatan minuman kopi susu, kopi manis, dan susu manis. Dalam merancang alat ini dibutuhkan pendekatan sistematis
dengan prosedur: perencanaan sistem kendali, penentuan input/output, perancangan pembuatan alat, pemrograman, dan
menjalankan sistem.

Kata kunci: PLC Mitsubishi, Push Buttom, Proximity, motor DC, lampu, dan solenoidvalve

1. PENDAHULUAN pengecoran bangunan, yang selanjutnya akan
dimasukan kedalam mobil molen untuk proses
1.1 LATAR BELAKANG pengadukan[2].

Berkembangnya llmu  Pengetahuan dan ~ Konsep otomatisasi pada _batching plan ini
Teknologi (IPTEK) yang semakin meningkat bisa dlterapakan_ pada proses Ial_nya seperti proses
dengan pesat seiring dengan meningkatnya pembuatan mesin pengaduk minuman kopi susu
kebutuhan manusia yang semakin besar, menuntut yang membutuhkan takaran yang bisa di atur sesuai
produsen atau pengusaha untuk menghasil barang dengan yang inginkan.
prodgksi lebih  banyak _Iagi untuk memenuhi 1.2 TUJUAN
permintaan pasar yang begitu besar. Idealnya untuk
memenuhi permintaan pasar yang begitu besar, para Tujuan yang ingin dicapai pada tugas akhir ini
pengusaha harus mempercepat proses produksi adalah:
dengan waktu yang sesingkat-singkatnya tanpa 1. Menghasilkan rancang bangun prototipe mesin
harus mengurangi kualitas barang tersebut. Dengan pengaduk minuman.
adanya perusahaan-perusahaan yang bergerak di 2. Menghasilkan program kontrol menggunakan
bidang manufacturing pembuatan mesin-mesin GX-Developer.
produksi ~ otomatis menjadi  solusi  untuk 3. Mengemplementasikan  sistem  automatisasi
meningkatkan hasil produksi dengan sistem menggunakn PLC Mitsubishi FXiy.
otomatisasi[1]. 4. Memperoleh karakteristik waktu setiap jenis

Dengan sistem  otomatisasi mampu proses.
mempersingkat waktu  kerja  seperti proses 1.3 PEMBATASAN MASALAH
pembuatan takaran bahan beton pada mesin
batching plan. Konsep dari batching plan ini adalah Ruang lingkup permasalahan dalam tugas akhir
mengatur perbandingan banyaknya material semen, ini dibatasi sebagai berikut:

pasir, kerikil, dan air untuk menetukan takaran
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1. Merancang alat pengaduk pengaduk minuman
berskala laboratorium.

2. Pemrograman PLC Mitsubishi FXin
menggunakan GX Developer sebagai software
pemrogramnya.

2. TINJAUAN PUSTAKA

2.1 Definisi Programmable Logic Control (PLC)

PLC (Programmable Logic Controller) adalah
komputer elektronik yang digunakan untuk
mengendalikan mesin-mesin indutri, pertanian
maupun rumah tangga dengan pengoperasian secara
digital yang disimpan dalam memory sebagai
penyimpan data dan akan beroperasi berdasarkan
digital 1/0 maupun analog.

Berdasarkan dari nama PLC ini sendiri adalah
sebagai berikut:

a) Programmable

Menunjukan kemampuan untuk membuat dan
menyimpan program yang telah dibuat kedalam
memory sesuai dengan kegunaannya.

b) Logic

Menunjukan kemampuan dalam memproses
input secara aritmatika dan logic, yakni melakukan
operasi membandingkan, menjumlahkan,
mengalihkan, membagi, mengurangi, AND, OR,
dan sebagainya.

c) Control

Menunjukan kemampuan dalam mengontrol
dan mengantur proses hingga menghasilkan output
yang diinginkan.

Selain dapat diprogram, alat ini juga dapat
dikendalikan, dan dioperasikan oleh orang yang
tidak  memilki  pengetahuan  di  bidang
pengoperasian komputer secara khusus. PLC ini
memiliki bahasa pemrograman yang mudah
dipahami dan dapat dioperasikan bila program yang
sudah dibuat dengan menggunkan software yang
sesuai dengan jenis PLC yang digunakan sudah
dimasukan. Alat ini bekerja berdasarkan input yang
kemudian menghidupakan (ON) atau mematikan
(OFF) sesuai dengan perintah yang sudah
tersimpan. Digital 1 menunjukan bahwa keadaan
yang diharapkan terpenuhi, sedangkan 0 berarti
keadaan yang diharapkan tidak terpenuhit®.

PLC mempunyai tiga tipe pengontrolan yang
dapat dikerjakan di antarnya adalah sebagai berikut:
1. Kontrol urutan (Sekuens)

a. Pengganti relay kontrol logic konvensional
termasuk timer dan counter,

b. Pengganti pengontrol card PCB,

c. Sebagai mesin kontrol auto , semi auto,
dan manual .

2. Kontrol canggih
a. Operasi aritmatika (+, -, *, ;)
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b. Kontrol analog (suhu, tekanan, dan lain-
lainya),

c. Kontrol servo motor,

d. Kontrol stepper motor .
3. Kontrol pengawasan

a. Proses monitor dan alarm,

b. Monitor dan diagnosa kesalahan.

c. Antar muka dengan
(RS230/RS422),

d. Jaringan kerja otomatisasi pabrik,

e. Local area network.

PLC mempunyai keuntungan dalam system
otomatisasi di antarnya adalah sebagai berikut:

komputer

1. Waktu implementasi proyek
dipersingkat.

2. Modifikasi lebih mudah tanpa biaya
tambahan.

3. Biaya proyek dapat dikalkulasikan

dengan akurat.

4.  Training penguasaan teknik lebih cepat.
5. Perencanaan lebih mudah diubah dengan
software.

6.  Aplikasi kontrol yang luas.
7. Maintenance yang mudabh.

8. Keandalan tinggi.

9.  Perangkat kontroller standar.
10. Dapat menerima kondisi
industri yang berat .

2.2 Motor DC

Motor listrik merupakan perangkat elektronik
yang mengubah energi listrik ke energi mekanik.
Motor listrik DC sama halnya dengan motor listrik
AC yang membedaannya hanya tegangan yang
digunakan AC atau DC untuk membangkitkan
medan magnet. Kontruksi motor listrik terdiri dari
dua komponen yaitu rotor dan stator. Rotor adalah
bagian yang bergerak yang bertumpu pada bantalan
poros terhadap stator. Stator adalah bagian
komponen motor listrik yang tidak bergerak dan
merupakan tumpuan rotor agar tetap di pososnya.
Pada motor DC terdiri dari kumparan-kumparan
stator dan rotor yang berfungsi membangkitkan
gaya gerak listrik yang melewati kumparan tersebut
sehingga terjadi suatu medan magnet antara stator
dan rotor®.

lingkungan



Gaya elektromagnet pada motor DC timbul
saat ada arus yang mengalir pada penghantar yang
berada dalam medan magnet. Medan magnet itu
sendiri ditimbulkan oleh megnet permanen. Garis-
garis gaya magnet mengalir diantara dua kutub
magnet dari kutub utara ke kutub selatan. Menurut
hukum gaya Lourentz, arus yang mengalir pada
penghantar yang terletak dalam medan magnet
akan menimbulkan gaya. Gaya F, timbul tergantung
pada arah arus I, dan arah medan magnet B.
Gambar 1 di bawah ini menunjukan kontruksi
motor.

kutub
. utama

rangka

angker
garis
netral

sikat
ara
= o

Gambar 1. Kontruksi motor

Belitan stator merupakan elektromagnet,
dengan penguat magnet terpisah F1-F2. Belitan
jangkar ditopang oleh poros dengan ujung-
ujungnya terhubung ke komutator dan sikat arang
Al-A2. Arus listrik DC pada penguat magnet
mengalir dari F1 menuju F2 menghasilkan medan
magnet yang memotong belitan jangkar. Belitan
jangkar diberikan listrik DC dari A2 menuju ke Al.
Sesuai kaidah tangan kiri jangkar akan berputar
berlawanan jarum jam.

Gaya elektromagnet pada motor DC timbul
saat ada arus yang mengalir pada penghantar yang
berada dalam medan magnet. Medan magnet itu
sendiri ditimbulkan oleh megnet permanen. Garis-
garis gaya magnet mengalir diantara dua kutub
magnet dari kutub utara ke kutub selatan. Menurut
hukum gaya Lourentz, arus yang mengalir pada
penghantar yang terletak dalam medan magnet akan
menimbulkan gaya. Gaya F, timbul tergantung pada
arah arus I, dan arah medan magnet B. Arah gaya F
dapat ditentukan dengan aturan tangan Kiri. Gambar
2 di bawah ini menunjukan arah gaya medan
listrik.

"\ arah medan
gagnetik

[‘\——[:\-\\ g

Gambar 2. Penentuan arah gaya medan Iistrik
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2.3 Proximity

Proximity switch atau sensor proximity adalah
alat yang bekerja berdasarkan jarak atau bentuk
objek terhadap sensor. Sensor proximity menditeksi
obyek dengan jarak yang cukup dekat, berkisaran
antara 1 milimeter sampai beberapa centimeter
sesuai dengan tipe sensor yang digunakan.
Perkembangan sensor dan transduser sangat cepat
sesuai kemajuan teknologi otomasi, semakin
komplek suatu sistem otomasi dibangun maka
semakin banyak jenis sensor yang digunakan®!.
Proximity Switch ini mempunyai tegangan Kkerja
antara 10-30 Vdc dan ada juga yang menggunakan
tegangan 100-200VAC. Pada Gambar 3 bentuk dari
proximity.

Gambar 3. Proximity

Hampir setiap mesin produksi baik diindustri
besar maupun kecil telah menggunakan sensor
proximity karena selain praktis sensor ini termasuk
tahan terhadap benturan ataupun guncangan®.

Proximity terdiri dua macam, yaitu;:

a. Proximity inductive

Sensor ini berfungsi mendeteksi objek yang
terbuat dari bahan besi atau metal yang berada
dalam daerah kerjanya. Meskipun terhalang oleh
benda non metal, sensor akan tetap dapat
mendeteksi selama dalam jarak normal sensing atau
jangkauannya. Jika sensor mendeteksi adanya besi
di area sensingnya, maka kondisi output sensor
akan berubah nilainya.

b. Proximity capacitive

Sensor ini akan mendeteksi semua objek yang
ada dalam daerah kerjanya baik metal maupun non
metal.

2.4 Relay

Relay adalah saklar elektronik yang digerakan
secara mekanik oleh medan magnet yang
ditimbulakan arus listrik yang mengalir pada lilitan
atau coil. Elektromagnetik relay didefinisikan
sebagai sebuah relay yang beroperasi atau reset
selama ada pengaruh elektromagnetik yang
disebabkan oleh aliran arus pada coil yang
membuat beropersinya kontak-kontak kontrol.
Relay digunakan untuk membuka dan menutup
kontak untuk mengontrol suatu sistem otomatisasi.
Pada Gambar 4 di bawah ini merupakan bentuk dari
relay.



Gambar 4. Relay
3. TATA KERJA

3.1 Bahan dan Alat

3.1.1 Bahan

Bahan yang digunakan dalam penelitian ini adalah:
1) PLC Mitsubishi FX1N 60MR;
2) Relay;

3) MCB;

4) Motor DC;

5) Proximity;

6) Limit switch,

7) Solenoid valve;

8) Heater;

9) Push buttom;

10) Skun kabel;

11)Kabel;

12)Trafo;

3.2 Pembuatan Sistem Mekanikal

Sistem mekanikal yang bekerja pada prototipe
ini adalah berupa motor dc yang dikelilingi oleh
tabung-tabung berisikan bahan minuman. Motor dc
ini akan berputar menuju tabung untuk mengisi
bahan minuman sesuai dengan perintah yang telah
terprogram pada memori PLC. Pada prototipe ini
terdapat tiga tabung penampung Yyang bahan
minuman seperti kopi, gula, dan susu. Tabung-
tabung dilengkapi dengan motor untuk membuka
dan menutup lajur bahan minuman yang dipasang
secara vertical dengan proximity. Pada Gambar 5
desain body mixing drink machine yang berbentuk
persegi lima.

13)Dioda;

14) Kapasitor;
15)Ducting;

16) Mounrale;
17)Baut;

18) Skrup;

19) Kabel number
20) Acrilyc 2 mm?

3.1.2 Alat
Alat yang digunakan dalam penelitian ini adalah:

1) Bortangan

2) Tang kombinasi
3) Tang potong

4) Obeng positif (+)
5) Obeng minus (-)
6) Kater

7) Kater acrilyc
8) Gergaji besi

9) Batu gerinda
10)Penggaris

11) Crimping
12)Solder

Gambar 5. Desain body dan tutup mixing drink machine

Setelah gambar general dibuat maka langkah
selanjutnya membuat gambar detail sebagai acuan
pabrikasi. Pada Gambar 6 dibawah ini detail body
dan tutup cashing mixing drink manchine.
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Gambar 6. Detail cashing body dan tutupa bawah atas

Setelah desain dibuat maka alat dan bahan
penunjang kerja di siapkan. Dengan adanya detail
gambar maka pembuatan siap untuk di pabrikasi
sesuai dengan tuntunan Gambar 3. Pembuatan body
dengan ukuran panjang 150 mm dan tinggi 300 mm
dibuat sebanyak 5 pcs. Khusus untuk body depan
dibuat berbeda dengan ke empat sisi body lainya
dengan menambahkan lubang berbentuk persegi
dengan ukuran panjang 100 mm dan tinggi 120
mm. cara pembuatan lubang seperti gambar 4 yaitu
dengan cara di bor pada garis dalam layout. Pada
Gambar 7 menunjukan tampak body depan mixing
drink machine.

Gambar 7. Part body depan
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Setelah semua bagian body part dibuat maka
proses selanjutnya adalah perakitan semua part
menjadi satu kesatuan yang utuh dengan cara di
lem. Gambar 8 dibawah ini merupakan hasil
perakitan body part keselurahan.

Gambar 8. Perakitan body mixing drink machine

Pembuatan tutup cashing yang berbentuk perseti
lima dengan panjang masing-masing sisi 153 mm
dengan sudut kemiringan 180° dan mempunya
lubang berdiameter 27 mm.

Setelah pembuatan tutup body maka proses
selanjutnya adalah dengan menggabungkan body
cashing, tutup cashing, tabung dan valve air seperti
yang ditunjukan pada Gambar 9.

Gambar 9. Perakitan tutup body dan tabung penamung

3.3 Pembuatan Sistem Elektrikal

3.3.1 Input dan Output

Penentuan jumlah input dan output langkah
awal pemilihan PLC yang digunakan dalam sistem
elektrikal pada prototipe mixing drink machine.
Dari data yang terdapat pada Tabel 1 dibawah ini
kita dapat menghasilkan keputusan PLC yang
digunakan. Maka dalam penelitian ini, PLC yang
digunakan adalah PLC Mitsubishi FX;y-60MR
yang memiliki 36 input dan 24 output.

Tabel 1. Input dan output

N Digital input Digital input

O| Alamat | Komponen | Alamat | Komponen
SW (Auto

1| X000 manula) Y000 Motor dc

2[xo001 |PB- |yoor | Screwsusu
konfirmasi




3| %002 PB_ Motor Y002 Motor _
manual close kopi
PB
. Motor
4 | X003 Mixing Y003 open gula
manual
PB_ Valve
5| X004 kopi Y005 Screw kopi
manual
PB_ Valve
6| X005 gula Y006 Screw gula
manual
PB_ Valve Motor
7| X006 susu Y010
close gula
manual
8| X007 P_B_ Valve Yo11 Motor
air manual open susu
9| X010 Emergency | Y012 Valve air
1 X011 PB_Susu Y013 Motor .
0 manis auto open kopi
1 X012 PB_!(OpI Y014 InQI!<ator
1 manis auto mixing
. Indikator
o1z | PBKOPI Fyo15 | kopi
2 susu auto
manual
- Indikator
Lixo1a | ProXImity yo1e | gula
3 center
manual
- Indikator
1 xos | Proximity 617 | gusy
4 kopi
manual
1 X016 Proximity Y020 Indl_kator
5 gula kopi susu
1 X017 Proximity Y021 Indl_kator_
6 susu kopi manis
1 X020 P_rOX|m|ty Y022 Indlkator_
7 air susu manis
Lixoor | ESKOPT | yoo3 | Konfirmasi
8 open
1 X022 LS_Kopi Y024 Motor
9 close close susu
21 o3 | LSQula | ygps | Motor up
0 open mixing
2 X024 LS gula | Y026 Motor
1 close down
mixing
2| X025 LS _susu Y027 Mixing
2 open
2 | X026 LS susu
3 close
2| X027 LS_mixing
4 down
2| X030 LS_
5 mixing up
Pemilihan PLC  Mitsubishi  FX;ny-60MR

merupakan PLC yang tepat untuk digunakan pada
prototipe mixing drink machine karena jumlah input
dan output pada PLC Mitsubishi FX;y-60MR lebih
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banyak, sehingga tersedia cadangan input dan
output. Pada panel prototipe mixing drink machine
ini terdapat komponen yang digunakan operator
sebagai kontrol seperti tombol push buttom, pilot
lamp, selector switch dan tombol emergensi.
Banyaknya komponen yang fungsi sebagai alat
kontol operator tergantung dari feature-feature
yang akan di terapakan pada alat ini. Alat kontrol
operator yang terdapat pada prototipe ini berfungsi
sebagai perintah feature, safety, power dan lampu
indikator. Pada Table 2 dibawah ini menunjukan
alat kontrol yang digunakan untuk menjalankan alat
ini.

Tabel 2. Komponen kontrol operator

Nama Jumlah

No. | Alat (Pcs)

Keterangan

Digunakan
untuk
menghidupkan
power dan
program  auto
atau manual

Selector
Switch

Digunakan
untuk  tombol
star, kopi susu,
susu manis,
kopi manis,
motor rotasi
manual, mixing
manua,  valve
kopi manual,
valve gula
manual, valve
susu manual,
dan valve air
manual.

Push
Buttom

Digunakan
untuk indikator
star, kopi susu,
susu manis,
kopi manis,
motor rotasi
manual, mixing
manua,  valve
kopi  manual,
valve gula
manual, valve
susu manual,
dan valve air
manual.

Pilot
Lamp

Digunakan
Tombol untuk

4 Emerge 1 mematikan

nsi mesin dalam
emergensi




Setelah  ditentukan alat  kontrol  untuk
pengoperasian operator, maka kita dapat membuat
desain layout panel dengan mengukur dimensi dari
alat push buttom, pilot lamp, selector switch dan
tombol emergensi dengan menggunakan program
auto cad. Pada Gambar 10 merupakan desain dari
panel kontrol mixing drink machine.
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Gambar 10. Layout panel

Desain panel kontrol yang telah dibuat maka
proses selanjutnya adalah memotong dan membuat
lubang pada acrilyc sesuai dengan ukuran Gambar
10 di atas. Pada Gambar 11 dibawah ini merupaka
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proses pelubangan dengan mata bor dan diteruskan
dengan pengeboran dengan batu gerinda.

Gambar 11. Proses pengeboran pe{hel

Setelah proses pembuatan panel, maka proses
selanjutnya membuat wiring diagram untuk
memudahkan instalasi listriknya. Gambar 12 dan 13
menunjukkan wiring kontrol input dan output PLC.
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Gambar 12. Wiring digital input
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Gambar 13. Wiring output PLC

3.3.2 Pemograman

Pemograman PLC Mitsubishi menggunkan
bahasa pemrograman diagram ledder yang diberi
nama GX Develover. Perangkat Ilunak ini
digunakan khusus untuk memprogram PLC merk
Mitsubishi. Adapun tata cara penggunakaan
perangkat lunak GX Develover untuk membuat
rangkaian ladder logic yang baru adalah dengan
langkah-langkah sebagai berikut:

Jalankan GX Developer sehingga akan
dimunculkan jendela penyuntingan diagram tangga
sebagaimana ditunjukan pada Gambar 14.

7 ELSOFT series GX Developer

J_L_J_J_J_JL
3 Zfe
_J_L_J z|4 1o 212 A @) 25l 8]
B e 3 e e e e o o

it )
Reaty

Gambar 14. Tampilan awal GX-Developer

Untuk memulai diagram ladder yang baru
mulailah dengan langkah-langka sebagai berikut:
1. Pilih menu Project > New Project atau Ctrl+N
seperti yang ditampilkan pada Gambar 15.
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2 MELSOFT series GX Developer,
WS Edit Find/Replace  Wiew Online Diagnostics  To

Mew projeck ... Ctrl+M

Open project .., ChrHG

Delete project ...

Edit: Data

Gambar 15. Tampilan tool bar new project

2. Setelah membuat project baru akan muncul
tampilan tipe PLC seperti pada Gambar 16.
Kemudian pilihlah tipe PLC uang sesuai dengan
yang kita gunakan. Pilihlah pada menu PLC
Series > FXCPU kemudian PLC Type >
FX1N(C) dan untuk Program Type > Ladder.

New Project [z|
PLL series
Cancel
PLC Type
|FRINE) |
Program type Label zetting
(¢ Ladder &
Csee I o

Gambar 16. Pemilihan jenis seri PLC

3. Setelah itu akan muncul tampilan seperti pada
Gambar 17, dan selanjutnya kita dapat memulai
membuat diagram ladder berikut langkah-
langkah pembuatan diagram ladder :

A - klik salah satu device, misal nya kita pilih
NO dengan klik pada toolbar, atau tekan F5

B - isi alamat dari device tersebut, untuk input
kita gunakan simbol 'X' dan angka di belakang
X adalah alamat dari input tersebut, misal : X0
C - Lalu kita klik 'OK"

J_é el gaese sy i nay | oo

2] 4 0 o ol éﬂJJ_ILJJ_D
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Gambar 17. Penggunaan simbol ladder diagram

4. Setelah itu akan tampil seperti gambar di bawah

ini, lakukan proses seperti pada penulisan input,
untuk output juga demikian. Gambar 18
menunjukkan cara pembuatan input atau output.
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Gambar 18. Pembuatan input dan output Gambar 21. Komunikasi komputer dan PLC
5. Setelah program kita buat, langkah selanjutnya 8. Klik pada menu >Online, > Transfer Setup,
adalah meng-convert program tersebut, klik > maka setelah itu akan tampil seperti terlihat di
Convert pada toolbar, lalu klik Convert pada Gambar 22.
sub toolbar atau klik F4. Pada Gambar 19 [———

menunjukkan proses convert ladder. el o0 | | | f ]

Seid  NETZOG) RETI LUk Ehems PLC AF
board board board board board board net |

COM [COM 1 Transmission speed [96Kbps

o I R

PIC  MRET/OH] MNET() CClnk  Eiemet  C24 E Bus
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Gambar 19 Convert Iadder a4 N%[H] NET(I CClink  Ethemet
System  image.
. i JJJJ TEL (FXCPU)
6. Setelah itu tampilan pada program akan | N | = —
. . €24  METADH) NET(l] CCLink  Ethemet
berubah, yang tadinya programnya di  blok
Close

dengan warna abu-abu akan hilang blok
tersebut, seperti Gambar 20. Gambar 22. Transfer Setup

B Jsm Setelah muncul tampilan seperti pada Gambar 25

ik G e S T maka klik > Connection Test, > OK, maka
sl M:} m @M komunikasi telah terhubung.

9. Setelah komunikasi komputer dengan PLC
terhubung maka proses berikutnya adalah
, I G| mendownload program ke PLC dengan cara klik

T pada menu >Online, > Write to PLC, maka setelah
m L itu akan tampil seperti terlihat di Gambar 23.

] (S oper (Unset project) - [LD(Edit mode) MAIN 5 Step]
Convert  View NN Diagnostics Tooks  Window  Help
A Transfer setup ...
Gambar 20. Ladder input dan output @ é_ ﬁF'é 4515_ j’;l; 1
Read from PLC .,

7. Setelah digram ladder di convert maka program \.'enfywmhp\_c —
siap di download dengan catatan komputer | Writz ta PLC{Flach ROM) ?MJ_
harus online terhadap PLC yang dihubungkan
dengan kabel serial RS 422. Adapun cara

-

menghubungkan komputer dan PLC dapat PLC user data ’
dilihat pada Gambar 21 dibawah ini. Esgﬁgor :

Gambar 23. Transfer dari kompliter ke PLC

Setelah transfer program berhasil, maka program
PLC sudah tersimpan kedalam memori PLC.
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4. HASIL DAN PEMBAHASAN
4.1 Rancangan system kendali

Sistem yang dikendalikan dapat berupa mesin
ataupun proses yang terintegrasi membentuk suatu
proses yang sering secara umum disebut dengan
kontrolled system seperti motor, relay, valve dan
lampu indikator. Dalam lapaoran skripsi ini
penyusun akan melakukan rancang bangun
prototipe mixing drink machine yang secara elektrik
dikendalikan oleh PLC Mitsubishi FX;y. Dimana
prototipe mixing drink machine adalah alat yang
berfungsi untuk mengolah bahan-bahan minuman
yang terintegrasi satu bahan dengan bahan yang
lainnya. Pada Tabel 3 memperlihatkan bahan-
bahan campuran untuk membuat minuman.

Tabel 3. Bahan-bahan pembuat minuman

PILIHAN BAHAN-BAHAN MINUMAN
MINUMAN | KOPI [ GULA | SUSU | AIR
SuUSU - Vv Vv Vv
MANIS
KOPI Vv Vv - Vv
MANIS
KOPI Vv Vv Vv Vv
SUsuU

Gambar 24. Prototipe mixing drink machine

Pada Gambar 24 merupakan bentuk dari prototipe
mixing drink machine.

4.2 Program diagram ladder berbasis PLC

Feature yang terdapat mixing drink machine ini
yaitu minuman susu manis, kopi manis dan kopi
susu . Adapun cara kerja dari feature-feature yang
terdapat pada mixing drink machine  sebagai
berikut:

A. Membuat minuman Susu Manis otomatis (SM)

Pembuatan Kopi Manis otomatis (SM) sama
halnya dengan proses pembuatan kopi susu, yang
membedakan kopi susu adalah takarannya tidak
menggunakan bahan kopi melainkan hanya susu,
gula, dan air dengan waktu yang sudah disesuaikan
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dengan rasa yang enak. Pada Gambar 25 urutan
blok diagram bahan susu manis.

e N

e
[ AIR ) \/(susu)
N Nl
\.
2] // \\ A
(GULA
N

A\MINUMAN SUsuU MANIS/

Gambar 25. Blok diagram susu manis

Cara kerja dari feature ini adalah sebagai
berikut:

1. Nyalakan mixing drink machine dengan
memindahkan selector switch 1 power pada
posisi ON.

2. Pindahkan selector switch 2 pada posisi auto
(X000).

3. Pilih tombol Susus Manis PB_SM (X011)

4. Tekan konfirmasi untuk menegaskan pilihan

yang di pilih (X001)

Pada Gambar 26 di atas menjelaskan sebagian
program ladder untuk minuman Susu Manis (SM),
untuk program selengkapnya terlampir pada
lampiran.

B. Membuat minuman Kopi Manis otomatis (KM)

Pembuatan Kopi Manis (KM) otomatis sama
halnya dengan proses pembuatan kopi susu, yang
membedakan dengan kopi susu adalah takarannya
tidak menggunakan bahan susu bubuk melainkan
hanya kopi, gula, dan air dengan waktu yang sudah
disesuaikan dengan rasa yang enak. Lihatlah
Gambar 27 urutan blok diagram bahan kopi manis.



. MINUMAN KOPI MANIS |
AN S

Gambar 27. Blok diagram kopi manis

Cara kerja dari feature ini adalah sebagai berikut:

1. Nyalakan mixing drink machine dengan
memindahkan selector switch 1 power pada
posisi ON.

2. Pindahkan selector switch 2 pada posisi auto
(X000).

3. Pilih tombol Kopi Manis PB_SM (X012)

4.Tekan konfirmasi untuk menegaskan pilihan

yang di pilih (X001)

Gambar 28. Pro m

Pada Gambar 28 di atas menjelaskan sebagian
program ladder untuk minuman Susu Manis (SM),
untuk program selengkapnya terlampir pada
lampiran.

C. Membuat minuman kopi susu otomatis (KS)

Pembuatan kopi susu otomatis (KS) di program
untuk menjalankan takaran untuk membuat Kkopi
susu dengan mengontrol tabung-tabung yang berisi
kopi, gula, susu bubuk, air panas, dan pengadukan
yang telah di program dengan waktu tertentu sesuai
perintah eksekusi. Lihatlah Gambar 29 urutan blok
diagram bahan kopi.
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Gambar 29. Blok diagram kopi susu

Cara kerja dari feature ini adalah sebagai berikut:

1. Nyalakan mixing drink machine dengan

memindahkan selector switch 1 power pada
posisi ON.

2. Pindahkan selector switch 2 pada posisi auto
(X000).

3. Pilih tombol Susus Manis PB_SM (X011)

4. Tekan konfirmasi untuk menegaskan pilihan
yang di pilih (X001)

BECIEE

Pada Gambar 30 di atas menjelaskan sebagian
program ladder untuk minuman Susu Manis (SM).

5. PENUTUP
5.1 Kesimpulan

Mengacu pada hasil dan bahasan, maka dapat
ditarik simpulan seperti berikut:
1. Menghasilkan prototipe mixing drink machine
berskala laboratorium.
2. Menghasilkan program ladder mixing drink

machine  menggunakan  software  GX-
Developer.
3. Seluruh proses automatisasi pada alat

prototipe mixing drink machine ini telah
berjalan dengan baik sesuai dengan yang
direncanakan.

4. Didapatkannya para meter waktu pada setiap
tipe minuman.



5.2 Saran

Pada prototipe ini terdapat kelemahan-
kelemahan yang perlu untuk upgrate, diantaranya:

1. Bahan simulasi pada prototipe belum sesuai
yang diharapkan, yang hanya bisa di simulasi
dengan material sterofoam yang seharusnya
dengan bahan sebenarnya yaitu kopi, gula,
susu dan air dikarenakan motor dc yang
digunakan pada screw tabung minuman tidak
mampu berputar, karena massa jenis kopi,
gula, susu terlalu berat sehingga perlu di
upgrate kembali.

2. Pada prototipe ini perlu menambahkan feature
untuk merester posisi motor dc yang yang
berfungsi memutarkan gelas kembali ke posisi
awal atau center.

3. Perlu ditambahkanya  perintah  untuk
membatalkan program apabila perintah yang
kita inginkan tidak sesuai.

UCAPAN TERIMAKASIH

DAFTAR PUSTAKA

[1] EKO PUTRA, Afgianto. PLC: Konsep,
Pemrograman dan  Aplikasi.  Gavamedia,
Yogyakarta, 2004.

[2] MITSUBISHI, Manual Programming FX
Series, Mitsubishi, Tokyo, 1993.

[3] SUMBODO, Wirawan. Sistem Pengendali
PLC. Jurusan Teknik Mesin Fakultas Teknik
Universitas Negeri Semarang, 2008.

[4] MITSUBISHI, Manual Programming FX
Series, Mitsubishi, Tokyo, 1993.

[5] http://electric-mechanic.blogspot.com

37



